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Welcome to Foundations in Photography. This course aims to equip you with fundamental 

visual and technical skills in photography as well as informing you about ways of thinking 

about and understanding photographs. Alongside the practical projects and experimental 

exercises, you’ll be directed to the work of other photographers which you can look up in 

libraries, book shops, galleries and on the internet to help you gain a perspective on different 

genres and creative possibilities. It’s important to apply this learning to your own productive 

output by emulating what you see and trying things out; that way you’ll absorb new 

knowledge and develop your expertise.

On completion of the five parts your tutor will help you judge whether you’ve gained 

sufficient skills and enough confidence to go on to further study with the Open College of 

the Arts. 

You’ll find more information about studying with OCA in your Student Handbook so keep 

this to hand as you work through the course. 

Your tutor 
Even though you’ll be studying from home you won't be working in isolation. You’ll have the 

support of your tutor, who is your main point of contact with OCA. 

Your tutor’s contact details are in the course pack. Once you’ve had a chance to look through 

the beginning of the course, email your tutor and explain your experience in photography 

and ask any questions you may have about the course or distance learning. Throughout the 

course you can contact your tutor by email if you’re stuck or need something clarified. Your 

tutor’s main job is to give you feedback on your assignments, which you should usually send 

to your tutor via email with a link to your learning log. In some cases you may choose to send 

prints through the post. 

Your tutor will comment on your work and try to help with any questions that may have 

arisen, and will offer constructive criticism as well as advice to help you progress. Your tutor 

will also help you to put the course projects and your own work into an appropriate context 

by making suggestions on texts to read, images to look at, places to visit and photographers 

and artists to study.

You can also draw on the support of your fellow students. There are lots of other OCA 

students studying photography. Use the OCA website forums as a place to meet them, share 

experiences and learn from one another. You can access these via the student website here, 

https://discuss.oca-student.com/. You may want to start by logging onto the forums and 

introducing yourself, perhaps find out who else is on the course and say hello. You will have 

automatically been included in the FIP group email and will receive regular email updates 

from fellow students.

Before you start
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Course Support
Course support are able to assist with things that you may find unclear in the exercises, 

projects and assignments and technical issues such as locating course resources etc. They 

can act as a point of contact in between tutor communications.  

Please email coursesupport@oca.ac.uk 

Course structure 
The course is split into five parts, each representing a particular aspect and genre of 

photography, which you’ll tackle through a series of exercises. At the end of each part of the 

course you’ll carry out an assignment task based on that part of the course which you’ll send 

to your tutor for review. Your tutor will get back to you as soon as possible but this may take a 

couple of weeks or more. Continue with the course while you’re waiting. 

Take note of the suggested date (on your tutor reports) for your next assignment but don’t 

feel pressurised. These course materials are intended to be used flexibly. Work at a pace that 

fits in with your life. If you feel you can complete a particular part of the course quickly, then 

by all means do so. If you feel you need a little longer, that's fine. However, if there’s going to 

be a considerable delay (e.g. several months) between assignments, contact your tutor and 

let them know what’s happening. 

To help you with each part of the course you will find a concept map that shows how the 

exercises and research connect and feed into making the assignments.

Making a start 
Start by skimming through the course guide to get a feel for the way you’ll work. Don't feel 

you need to read every detail at this stage; this is just a chance to get your bearings. Once 

you’ve done this, contact your tutor (see above) and think about what equipment you’ll 

need. 

Work through the course in the order it’s written. Read the first part of the course thoroughly 

and ensure you have everything in place before starting. It’s a good idea to read each section 

several times before you start work so you know exactly what you’re supposed to be doing. 

Learning Log
All OCA Photography and Moving Image courses require you to have an online learning 

log. You may still want to work with a notebook that is handwritten, but for the purpose 

of documenting your work and for your tutor to see your progression, an online learning 

log, sometimes referred to interchangeably as a blog, is the best vehicle. Handwritten 

notes and sketches can be scanned or photographed and uploaded to the blog . To protect 

your security the blog can be password protected, although the likely hood of someone 
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happening upon your blog randomly is quite unlikely.

Each time you complete an assignment, you will upload it to your learning log. You do not 

have to include every exercise in the learning log, although some students do. It is up to you. 

As a minimum guide each assignment and associated project tasks should be uploaded to 

the learning log.

Don’t worry about setting up your blog this will be covered in the introductory exercises of 

the course.

If you’d like more information about learning logs and blogging please see the ‘Resources’ 

section on the OCA student site.

Reading and research
It’s vital that you look at the work of other photographers and understand the 

different genres of photography. Juliet Hacking’s Photography: The Whole Story, 

(London: Thames & Hudson, 2012) is an anthology of photographers, genres and 

different approaches with accessible texts that should help you to think about photography 

more critically.

Throughout this course, you’ll be encouraged to look at the work of photographers and 

artists. Review their work critically, from the perspective of the criteria you’re learning 

through the course: composition, framing, subject, genre, light, etc.  Research means raising 

questions and looking for answers. Apply what you learn to both your own practice and the 

way you review other photographer’s images. 

Always use quotation marks if you copy comments or reviews from other writers. If you 

progress to degree level study with OCA you’ll have to apply academic conventions to all the 

writing you do, using the Harvard referencing system. It’s not mandatory for this introductory 

course, but if you intend to study further you’d be well advised to start getting to grips with 

this now by looking at the study guide to Harvard referencing on the student website. But 

your research shouldn’t simply consist of quotes or cut and pasted sections of writing. You 

must digest intellectually what you’re learning and show that in your writing.

Print quality
Make sure you look at the course as a PDF online as well as the printed copy. You’ll find the 

image quality may vary considerably. You can find the PDF of the course on the OCA student 

site. This will illustrate the difference between medias of presentation.
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Tip 
If you gain inspiration from photography magazines, try to offset an amateur perspective 

with a more advanced one. So if you’ve read amateur photography magazines, also look at 

The British Journal of Photography or an online site like lensculture.com. 

Photographic magazines have quite a strong focus on the latest equipment. Beware of 

the false assumption that you can’t take good photos because you don’t have the best 

equipment. Even a mobile phone could be appropriate for making candid photos. What’s 

important is the end result. Don’t limit or ‘close down’ your understanding about what 

photography is or can be. All photography relies on the choices made by the photographer, 

so it can become whatever you make of it.

Image-editing software
As a student you’re eligible for student pricing, which gives you significant discounts on 

software and hardware. For this course you’re recommended to use Adobe Photoshop. You 

can download a free 30 day trial of Photoshop to get you started. 

You can subscribe to different Adobe Creative Cloud options here:  

www.adobe.com/uk/creativecloud/buy/students.html

Photoshop is an extensive image-editing program which allows you to create layers 

and special effects. With the Adobe Creative Cloud Photography subscription, you also 

get Lightroom for organising your photographs and Camera RAW for editing in highest 

resolution RAW format.

Don’t be daunted by having to learn a new program; you can usually get up and running in a 

few hours. Buy a book on Photoshop that’s written specifically for photographers, like Adobe 

Photoshop for Photographers by Martin Evening and Jeff Schewe (Burlington, MA: Focal 

Press, 2011) rather than a general book that will teach you things you’ll probably never use.

Adobe have a suite of online tutorials available, most of which can be accessed for free, to 

support your skills as they develop. More information here, https://helpx.adobe.com/uk/

photoshop/tutorials.html
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Good study begins with a decision to improve old skills, knowledge and thought processes 

and gain new ones. You’ll need to re-affirm this decision periodically as you progress through 

the course, particularly at times of difficulty. Expecting, and learning to tolerate, difficulty is a 

part of learning. 

Goals: Set yourself study goals throughout the course. If you lack skills in a specific area, 

put particular effort into that area. In Foundations in Photography (FiP) one of your primary 

goals is to understand the five genres of photography. Structure your goals in a way you can 

manage and take one step at a time.

Discipline: Study requires discipline, particularly in your structuring of time.  Carefully 

schedule your time to encompass both practical projects and research. Keep reminding 

yourself of your goals and learn to prioritise tasks when there are other demands on your 

time.

Criticism: A vital part of learning is receiving and digesting your tutor’s feedback. You won’t 

get unbridled praise – if that’s what you want, you’re probably not ready to study. A tutor’s 

job is to give you an educated appraisal of your photographs based on the aims of the course 

and to give you advice on how to improve. Be open to both positive and negative criticism 

and take on board your tutor’s comments. Your tutor’s feedback will relate to the technical, 

aesthetic and intellectual aspects of photography – not their own taste. It’s crucial that you 

learn to perceive your own work in this objective way. If you strongly disagree with your 

tutor’s comments, email them and explain why. This is a key part of the learning process. 

Practice: A skill is a practised ability, a facility in doing something. You can read an instruction 

manual on playing football, but only physical repetition of a skill like accurate kicking will 

improve your ability. So go out and search for images. Practise technical skills like fill-flash or 

study a particular subject or a photographer – whether there’s an ‘idea’ or driving inspiration 

or not.

New knowledge: You’re setting out on a journey where you’ll sometimes feel like a foreigner 

who doesn’t speak the local language. The best way to absorb new knowledge is through 

repetition and practice. It helps if you connect your photographic practice to different areas 

of your life to enlarge its ‘sphere of interestedness’.

If you find it hard to master something, frustration can make you feel hostile to knowledge. 

Don’t mistake disagreement for frustration. Be open, take as much as you can, then move on. 

Production: The foundation of artistic education is the production of artworks. Produce 

work no matter how ‘dry’ it feels. Take a genre like portraiture and put it to work. What can 

you do photographically with a face? Some light, maybe a candle, a strange hat, a change in 

location? What can you come up with?
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Don’t stop because you’re not ‘in the mood’. Even times of despair and grief have been 

immortalised in artworks, from Edvard Munch’s early expressionist paintings to Picasso’s ‘Blue 

Period’. A bad day could be when you produce your very best work.

Technical skills: Read about the technical aspects of your medium and put this knowledge 

into practice. Learn about the shutter, focus, aperture, depth of field or different kinds of 

light, then practise until they become part of your ‘toolkit’, your decision-making process 

when making photographs. You’ll find technical tutorials on photographic techniques in this 

course and on the web.  Evaluate your technical skills periodically and build on them if you 

sense you’re lacking in crucial areas.

Technique: Technique is a particular use of technical skills. For example, Rembrandt used 

layers of paint and varnish to achieve luminosity in his oil paintings. Don’t get too hung up 

on technique; most photographers don’t know all the techniques and don’t need to. They 

only need those they’ll use and these are often few. Technique is something you’ll pick up 

from other artists and refine throughout your studies and your career. 

Intellectual skills: Developing your thought processes is vital to all study. The standard 

critical thinking techniques of analysing and questioning form the foundation of this 

approach. These should be based on the new skills and ideas you’re learning as well as on 

your own inward convictions. Acquiring knowledge of all kinds will deepen and inform your 

creativity. Life experiences are also a vital source from which to draw.

Do research in libraries and on the internet. See what other photographers have done 

with the same subject. Study the history of photography. Another key area of study as you 

move through the degree pathway is photographic theory. Images have long been written 

and talked about. Visual art has often had intellectual foundations like Surrealism, ‘New 

Objectivity’ or ‘Subjective Photography’. These ideologies help artists direct their creative 

output. All this may seem difficult at first, but it’s likely that you’ve been engaging with some 

of this theory at a subconscious level and you’ll be rewarded with a deeper clarity about what 

you make. 

Experimentation: All materials and technologies have specific characteristics – for example, 

the frozen stillness caused by the shutter in photographs or, conversely, the blur when using 

longer shutter speeds. These inherent photographic characteristics can be the inspiration for 

experimentation, which is vital for renewal in the arts. Any facet of photography can become 

the genesis of new ideas. The mobility or smallness of a phone camera could be something 

that sparks an experiment in that kind of image-making.

Aesthetic skills: Aesthetic evaluation is much more than a personal taste reaction – ‘I like this’ 

or ‘I don’t like that’. Aesthetics deals with the coming together of objective picture elements 

– materials, surfaces, textures, light and shadow, lines, shapes, forms, colours – and the 

subject’s place within all these visual qualities. This leads to our interpretation of the image.
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Your initial questions when viewing a photograph should be, ‘What is the subject?’  ‘What 

are the objects the image depicts?’  ‘How does the artist depict these objects?’  There isn’t a 

single element of a picture that doesn’t play some part in the overall visual effect. The better 

you understand these elements, the greater your ability to use them,

Personal talent: Notions of personal talent are rife in the arts and it can end up being a 

limitation if you think you don’t have any talent. Talent is basically ability. It’s not necessarily 

a ‘special ability’ or a ‘natural ability’, though it may be. Talent is about what you are and the 

things you’ve learned and you can nurture it by practice, research and wider engagement. 

Whether you develop a special ability will be something you’ll discover further down the line. 

For now, try to be realistic about what you do and get on with making pictures.

Inspiration: Inspiration is the most valuable commodity in the arts: that new idea, that bold 

energy, that fascination. Ideas seem to ‘come out of the blue’ but you can play your part by 

evaluating, pursuing, nurturing and realising them – not leave them in a sketchbook. Then 

you’ll experience the joy of a flow of ideas. Indeed, by realising your ideas you’re realising 

your self.
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Exercise 0.1 Set up a blog
We’ve created a Wordpress blog template for Photography and Moving Image students to 

use for their studies here at the OCA. To access the template and guidance on how to set 

up a blog with Wordpress, see this guide on the OCA student site:

www.oca-student.com/resource-type/study-guide/oca-wordpress-blog-template

This guide will help you to set up your blog, covering areas such as downloading the 

appropriate template, importing the template into Wordpress, creating the menu 

structure and categorising posts.

The guide also allows you to request additional assistance from OCA should you have any 

concerns about the set up of your blog. You can also email help@oca.ac.uk for support 

from OCA’s IT Team.

Remember, you’ll need to do some administration in the background of your blog. Your 

structure will need to consist of these main categories, each with sub-categories:

Home
• Pressing ‘Home’ will just lead you back to the front page of the blog, like the 

homepage of a website, where you can access all the sections.

About
• Here you can write anything you like about yourself and your studies.

Assignments
• Assignment 1

• Assignment 2

• Assignment 3

• Assignment 4

• Assignment 5

Coursework
• Part One Workflow

• Part Two Image

• Part Three Communication

• Part Four Experimentation

• Part Five Exhibition

These blog posts should be accompanied by a short written summary about your 

progress, what you’ve learned and your response to the process and the photographic 

results.
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Research & reflection
• Research

• Photographic analysis

• Reading

• Reviews

• Reflection

• OCA student blogs
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Part one 

Workflow: Landscape and 

environment 

Foundations Photography

Stephen King, Brownfield
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Every exercise, project, and every piece of research in Foundations in Photography is a 

building block to improve your photographic practice and understanding. Exercises and 

projects equip you with the technical, visual and creative skills and research provides you 

with the knowledge to make successful assignments at the end of each part. This concept 

map illustrates the chunks of knowledge and skill you will obtain.

Key

Technical and visual skills

Creativity and communication

Contextual Knowledge

Assignment One Square Mile

Printing

Making a contact sheet

Avoiding classic mistakes

Long and fast exposure

Photographing in diffused light

Controlling exposure: bracketing

Picture Analysis: Shibata

Understanding Form and Content

Evaluating your photos

Light and Shadow

Light meter

Image editing: cleaning and selecting adjustment

Basic image editing: contrast, colour and crop

File types

Uploading and organising

100 photos

Framing and composition skills

Camera skills



17 Foundations in Photography

Part One aims to get you up and running with an efficient workflow so you can concentrate 

on making photos. Working within the genre of landscape and the environment, you’ll 

learn how to upload and organise your photos on your computer and make basic image 

adjustments. You’ll develop some fundamental visual and technical skills that you can put 

into practice in all your photography. A single course can’t hope to teach every student 

how to use their particular camera, so it’s vital that you study your camera’s user manual to 

become familiar with how your camera works before you start work on the course.

In Part One you’ll learn how to:

• apply basic compositional skills

• organise files and folders in Adobe Bridge (Bridge is free, but you don’t have to use 

Bridge if you prefer to use Lightroom or another means of organizing your photographs)

• control and emphasise light and shadow for visual effect

• make creative use of fast and slow shutter speeds

• avoid the classic mistakes of amateur photographers.

You’ll also start to develop your understanding of landscape photography.

Before you start the first project, you’ll need to set up your camera and give some thought to 

framing and the basics of composition.

Setting up your camera
1. Set your camera to Manual Mode. It’s vital to shoot in Manual (M) rather than Program or 

Auto modes so you can learn how to control the camera.

2. Set file type to RAW. Most cameras allow you to shoot images of different sizes (pixel 

dimensions) and file types (JPEG or RAW). Choose RAW to get the highest possible 

quality. When you upload your images to a computer, you’ll see they have a proprietary 

file name suffix that indicates they are RAW files. If your camera doesn’t have RAW, 

choose the best quality setting you have.

3. Set ISO. Always aim to shoot at the lowest ISO setting (80 or 100 depending on your 

camera) because this will increase the resolution of your images. In low light you can 

choose a higher setting, but you will notice (particularly with compact cameras) that your 

images lose resolution and become ‘grainy’.

4. Set ‘White Balance’ to Auto. Light has different colours – or tints. Morning light is 

more blue than midday light; household light bulbs can give images an orange cast. 

If you’re noticing odd colour results using the Auto white balance, you’ll have to use 

Manual and choose the right manual balance (e.g. flash) for the situation. If you shoot 

in an environment lit by fluorescent  lights, you’ll probably notice a green or a brown 
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colour cast. You can correct these later, but it’s best to do so in-camera by choosing the 

Fluorescent white balance setting.

5. Light meter types. Your camera ought to have a choice of three types of light meter:

• Evaluative

• Centre-weighted

• Spot

Evaluative or centre-weighted should work fine for most situations, but when available light 

is varied and of high contrast you may find the light meter gets the exposure wrong. This 

is when you should use the spot meter, which measures the light of a small area you select 

– someone’s face, for example. If you don’t have a spot meter function, you should be able 

to point the camera towards a mid-toned subject, press the shutter half way to ‘hold’ the 

exposure, re-compose your picture and shoot.

6. Exposure control. When light enters your lens, a sensor measures it. Too little light results 

in an under-exposed picture (it’ll come out too dark); too much light results in over-

exposed (the picture comes out too bright). You adjust the exposure with three controls:

• The f-stop (indicated by a number like f2.8 or f5.6) which controls how much light is 

landing on your camera’s sensor via a diaphragm in the lens.

• The shutter speed (indicated by a fraction of time: 1/250th of a second – or 1sec, for 

example).

• The ISO 80 is low and requires more light; 1600 is high and means you can shoot in low 

light situations, but with the disadvantage of increased grain.

Evaluative Centre-weighted Spot
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Framing
All photographs are framed selections. The frame can be a ‘window’ or a ‘canvas’ – you can see 

through it or construct within it. Look at the two framing orientations below: portrait/vertical 

and landscape/horizontal. Which you use depends on the subject you’re photographing. For 

example, the long, thin, vertical shape of a tall building may suggest a vertical framing. The 

wide, horizontal impression of a landscape suggests a horizontal framing.

The four edges and four corners of the rectangle ‘cut off’ the scene you choose to frame: they 

outline your view.

You may also have seen examples of oval framing in nineteenth-century portraiture. You can 

experiment with any kind of framing if you like – circles, triangles, hexagons – but for general 

purposes portrait and landscape are the most widely used.

Google the work of Saul Leiter. He cleverly uses the frame as well as foreground objects like 

car window frames to create a tight, subject perception

Landscape/horizontal framing

© Dewald Botha, OCA alumni

Portrait/vertical framing

© Dewald Botha, OCA alumni
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Composition – the basics
A composition is an arrangement of shapes within the frame. Composition is largely about 

visual balance. 

• The first thing to consider is your subject. What is it you are photographing and where are 

you placing it in the frame? E.g. the building in the centre of the frame below is the main 

subject.

• If you have more than one subject, e.g. two people, consider the balance of these two 

‘points’ in the frame.

• Consider the background, i.e. the area directly behind the subject: the hills and sky below.

• Think about the surrounding environment of the main subject(s) and whether that 

distracts attention from the subject. The lake below is very smooth and bright making 

the central building stand out.

Central composition
The photograph above shows the most ‘obvious’ composition that reflects the way our eyes 

work, focusing our attention on things centrally. The eyes go straight to the structure in the 

lake, which is framed on the line of the horizon between the lake and the sky. It is neatly 

‘embraced’ by the surrounding hills, which adds to the central emphasis.

With central compositions it’s vital to check that there’s nothing poking out behind the main 

subject, or otherwise distracting from the clear outline and shape of the object.
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Shapes, planes and lines
The best way to compose the different objects in the frame is to think of them as shapes, 

planes and lines. In the photo you’ve just looked at, the structure in the lake is a cylinder 

sitting on a flat plane. The mountains form an irregular dark band running across the middle 

of the frame. The irregular cloudy forms in the sky cover the top of the frame with gradually 

changing tones. But even there you can see a distinct oval-shaped cloud above the building. 

Only the central structure is evidently ‘man-made’. All the other shapes and forms are natural 

and so the building stands out as a manufactured form against natural forms. 

In the image below, the bold triangular shape of the hill forms a background for the pattern 

of geese.

Tones within the frame
Tone and colour is also a vital part of composition. The cylindrical building in the centre of 

the frame (on page 20) is emphasised visually because it’s darker than the tones around it.  

This emphasis created by tonal contrast – a dark subject against a light background or a light 

subject against a dark background – is a strategy that’s often used in composition. See how 

the darker geese stand out against the middle-grey hill?
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Dividing the frame
The frame can also be divided into 

sections so that different areas act 

as ‘frames within the frame’ in the 

way that a doll’s house illustrates 

different domestic scenes. The pool’s 

edge in the photograph above 

creates a blue frame that divides the 

view between inside and out. Note 

how your eyes go to the red shapes 

in the pool, then to the steps, then 

along the line of the pool.

Here the unfinished building forms 

a pattern that reflects the angular 

frame. Notice also how the frame is 

divided into the man-made linear 

shapes of the building and the more 

natural forms of the shrubs, grasses 

and ground.
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Complexity
Even when the contents in the frame seem overwhelmingly complex, dominant shapes 

appear in the field of vision.

In the photograph above a complex environment is resolved into a balanced composition 

with the three figures and the boxes on the trolley forming a row against the urban 

backdrop. 

Using formulaic compositions and subjects, like close central images of flowers or rows 

of similar objects, reduces photography to graphics and won’t teach you to deal with the 

complexity of everyday life. You’ll learn much more by trying to compose complex situations 

than by looking for ‘ready-made’ compositions.

© Ben Robinson, OCA student
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Layers
The photograph below has three distinct layers that lead the eyes back and forth: the 

foreground rocks, the smooth plane of the river and the vertical cliff face.

Viewpoint
The high viewpoint used below, looking down on the subject, allows the frame to be filled 

with the landscape in the background. Note how the figure’s head stands out against the 

bright lake on the right. Always try to seek out interesting viewpoints.
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Points
Try to balance significant points of interest in the frame, as OCA student Chris Woolgar did 

here, balancing the palm trees with the pyramid in the background.

You can read more about Chris’s image at: www.weareoca.com/photography/two-points/

You’re now ready to start working through the projects. As you do so, collect exhibition 

catalogues, cut-outs or articles from newspapers and magazines, etc., and store these along 

with any handwritten work you do

© Chris Woolgar, OCA student
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For this project your task is to make 100 photographs in 30 minutes. You can choose to shoot 

in any environment you like, inside or outside. You can shoot in your own home or in a public 

space. But do it now! Working quickly and productively can help turn off the ‘inner critic’.

Vary the subject and shoot a variety of close and wide shots. Make conscious use of the 

frame to create compositions that balance shapes and tones. Use wide-angle and telephoto 

focal lengths, and move around the subjects. Think in terms of visual effect and take as many 

different framings, angles (high, low, birdseye, ant’s perspective, etc.) and viewpoints as you 

can.

Time yourself: you have 30 minutes to make 100 photos! Don’t think too much. This isn’t 

about quality, it’s about quantity. Stop after 30 minutes.

Project 1 100 Photos 

Exercise 1.1 Uploading, organising and reviewing your 

photographs
1. Upload your photographs to a computer.

2. If you’re using Adobe Bridge, the Photo Downloader should automatically open when 

you connect your camera to your computer and turn the camera on. If not open 

Bridge.

3. Check the box that 

says ‘Convert to DNG’. 

That’s the Digital 

Negative file type. It’s 

a RAW file type and 

you should always 

keep this original 

image file as an 

archive image. If your 

camera came with its 

own software and you 

prefer to use that, you 

should always retain 

a copy of the original 

RAW file, CR2 for 

example. 
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• You can work on the RAW image in Camera RAW, but for more extensive image 

editing, you’ll need to open the image in Photoshop and save it as a PSD (Photoshop 

file) or a TIFF file.

• When you come to upload your photos to a blog or in an email attachment to send 

your tutor, you should always send a lower resolution COPY of the photo.

4. Click ‘Get Media’. Your image files will be uploaded and saved in an automatically 

created folder probably named after the date you took them. Re-name the folder 

Project 1_100 Photos.

RAW file

PSD or TIFF file

Low Res file
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5. Review all the images in Bridge. 

• Do any stand out? You can mark these with stars: select the image, choose Label > 

make your choice of 1 to 5 stars or other labels.

• Do any interest you in terms of their visual effect or composition? View these 

larger (usually by clicking the spacebar) and re-name the best photos with more 

meaningful titles to help you identify them.

6. Select the hard drive and folder (for example My Pictures) on which you’ll save all 

your photographs for Foundations in Photography.

• Create five folders and name them after each part of the course: FiP 1 Workflow, FiP 2 

Image, etc. You may also want to make sub-folders for different projects and exercises 

as you go along.

• Place ALL the photos you make and any documents you write into these folders. 

You’ll need them later in the course.

7. Now move your Project 1_100 Photos folder into the FiP 1 Workflow folder.

8. Upload your final selection to your learning log as small thumbnails.

Important note: Always make back-ups or copies of your photographs on an external 

disk drive to guard against problems like disk failure and viruses.
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File types
Mostly you’ll use Save As... to save the file as a different file type. Use these file types:

• TIFF files for high-quality general work.

• PSD (Photoshop) files for high-quality composite images with layers.

• JPEG or PNG files for the internet. You only Save As...these file types when you’ve finished 

editing your photo as one of the higher resolution types (tiff etc.).

When you save as a JPEG, you’ll be presented with JPEG Options. Choose Maximum and the 

optimum image quality. JPEG uses file compression that results in a loss in quality.

Image size
Image files are usually large and it’s best to keep them large to retain the maximum 

resolution for printing and archival purposes. But when you want to send them over the 

internet to your tutor, you’ll need to make them a lot smaller:

• Open your Image Size dialog and reduce the longest edge to 1500 pixels.

Or

• Reduce Resolution to 72ppi to make very small files.

The Image Size dialog should tell you the resultant size of your image in megabytes. The 

image file below has gone down from 10.6 Mb to 84.4Kb – a small size suitable for sending in 

email attachments.

Be aware that reducing the resolution will cause images to look less sharp and more 

pixelated. If you’re unhappy with the look of your photographs when they’re reduced, undo 

the previous action and increase the Resolution to 150 or 200 ppi. Aim for an image size of 

under 1Mb for internet use.
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Exercise 1.2 Basic image editing
1. Select a good photo from your 100 Photos series and open it in Photoshop.

• If the photo is a RAW file it will open in Camera RAW where you can edit the RAW file 

non-destructively. Which is what we’ve used here. Click Open Image to open it in 

Photoshop.

• If the photo is of another file type it should open in Photoshop.

2. Click the Histogram tab if it isn’t open. It gives you information about the tonal range 

of your photo. The left side represents the shadows, the middle area is midtones and 

the right is highlights. Any spikes on the right indicate over-exposure.

3. Choose Image > Adjustments > Levels. Levels has a histogram of its own. Move the 

slider in the middle to the left to lighten the midtones and to the right to darken the 

midtones.

• This may feel counter intuitive, but what you’re doing is setting the mid-point and 

therefore widening or narrowing the tonal range on either side.

Shadow   Midtones    Highlight

   Lighten midtones  Darken midtones
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4. Black Point: The most common adjustment that photographers make is to the 

shadows and the highlights. By moving the left (shadow) slider to the point where 

the histogram meets the baseline, you can ensure that your darks will be deep black. 

This sets the black point.

5. White Point: The histogram below represents an image that is quite dark. Move the 

right (highlight) slider to the left of the histogram. Take care because this can over-

expose the highlights.

6. How does the photo look? Adjust it to your liking.

7. Now choose File > Save, and give your photo a name, a file type (choose Photoshop), 

click Save and close the image.

Move the shadow slider to meet 

the histogram on the left 

Move the highlight slider to 

meet the histogram on the right
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Exercise 1.3 Adjusting colour
Sometimes the colours in a photograph need tweaking because the lighting conditions 

they were made in have left a ‘colour cast’. Or you may think the ‘feel’ of the light is 

too cool and needs to be warmed up. Select an image that you’re not happy with and 

experiment with adjusting the colour.

1. Open a RAW image file in Camera RAW where you have the simple Temperature slider 

that allows you to shift colour temperature to the left to ‘cool’ an image and to the 

right to ‘warm’ an image.

2. Using the White Balance Tool, click on part of the image that should be white; this will 

automatically correct white balance. 

3. Click Done to close the file or Open Image to move the image into Photoshop.

4. Open another photo, this time in Photoshop. Choose one that is too blue.

5. In Photoshop choose Window > Layers to open the Layers palette, then Window > 

Adjustments to open the Adjustment Layer palette. Click on the scales icon in the 

Adjustments palette. This opens a Colour Balance Adjustment Layer just above your 

image (which will be called Background).

WarmerCooler
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Tip
All visual artists must master the visual and technical aspects of their medium but don’t fall 

into the trap of thinking that good photography is all about technique. Good photography is 

invariably about good subjects.

6. The image below has a blue cast that is subduing the golden yellows of the field  and 

making them green. If your image is too blue, subtract blue by moving that slider 

towards the yellow.

7. In the image below, increasing Red (reducing Cyan) and increasing Yellow (reducing 

Blue) brought out the colours of the field.
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Making selective image adjustments
There are various ways to adjust the contrast in a photograph. You can work with Levels and 

Curves to correct, increase and decrease contrast. The photo of building foundations below 

has a few basic problems:

1. There are specks of dust in the sky.

2. The photo has a blue cast.

3. The sky is too bright, taking attention away from the concrete forms which are the main 

subject of the composition.

How could you resolve these problems?

1. Removing dust
Create a new layer above the image layer (Background) and use the Healing Brush to remove 

the dust. This is done by sampling a clean section of the image (alt/option click with the 

Healing Brush) and painting it over the dust.

This process of cleaning is called ‘spotting out’. You can do it 

directly on the image, but it’s often preferable to create a layer 

above the image like this in case you’re not happy with the work 

you’ve done. But be sure to select Sample: Current & Below in the 

tool bar. Note that different programmes should have this facility 

so just Google “How to spot out photos in...[my programme]”.
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2. Correcting the colours
Insert a Hue & Saturation adjustment layer above the image layer (Background) and reduce 

the saturation of the Blues to -20 to take some of the blue out of the picture.

3. Reducing the brightness of the sky
Insert a Levels adjustment layer above the image layer (Background) and reduce the Output 

slider on the right (the highlights of an RGB photo) from 255 to 230. This reduces the 

brightness of the sky, but also the whole image.

Reducing the Output to 230 is drastic; you wouldn’t normally go beyond 250 so that the 

whites were just off paper white. But here the adjustment layer’s mask is used to block out 

the Levels adjustment on all but the sky. You do this by selecting the Adjustment Layer’s 

mask (to its right) and then paint black onto the image (actually the mask) with the brush 

tool. The black paint masks the Levels adjustment from affecting the image.

This adjustment layer and all layers can be reduced in Opacity, thereby lessening the effect. 

Reduce the opacity to 0% and then gradually lift it until you notice the change. Usually you’ll 

need much less of an adjustment than you initially thought.
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There are more exact ways of making selections - particularly of bright areas like skies.  

1. Go to the Channels tab, next to the Layers tab. If the Channels tab is not visible, go 

Window> Channels.

2. In the Channels tab you will have four channels, an RGB combined channel and three 

separate channels for Red, Green and Blue.   

• Click on each of the three colour channels making each one the only visible channel.

• Notice how the image goes black and white and emphasizes different colour values 

in that channel.  

• With landscapes like the one shown, the Blue channel is often the most useful 

because it brightens the sky.  

3. Drag the Blue channel onto the New Channel icon  to create a copy of the Blue 

channel.

4. Now press Control L (Windows) or Command L 

(Mac) to open Levels.  

• Moving the mid-tones slider to the right 

will darken midtones, making them more 

intensely black.  

• Moving the highlight slider to the left will 

brighten any pale greys, making them white.  

• Do you notice how the channel now looks 

like a Layer Mask?  That’s exactly how you’re 

going to use it.  

5. To select the channel, Control Click (Windows) or Command Click on it.  This loads it as a 

selection.  

6. Click on the Layers tab to go back to the Layers palette and create a Curves adjustment 

layer.  You will see that the new adjustment layer appears with a Layer Mask that 

corresponds exactly to the selection you made in the Channels palette.  

7. Reduce the highlights in the Curves palette and you will see all the bright areas of your 

image reduce in brightness.  Don’t over-do it.  Aim for a natural look.  

This technique is extremely useful because you can create another Curves adjustment layer, 

click on the Layer Mask while pressing Alt (Windows) or Option (Mac) and copy the Layer 

Mask to the new Curves layer.  You then press Control I or Command I to invert the mask so 

you can increase the contrast of only the land element of your picture without affecting the 

sky.  
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Contrast adjustments
The next stage is to increase the contrast of the concrete blocks. Using a Curves adjustment 

layer, ‘pin down’ the shadows and the highlights by clicking on the curves line (red circles).

Now increase the contrast of the midtones only by using the arrow slider (with the little hand 

– blue circle). Place it on the image itself and lift up for an increase of brightness down for a 

reduction in brightness. This puts another point on the curve’s adjustment line at the exact 

point (blue circle on the line) that corresponds to the tonal values of the image.
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Exercise 1.4 Cropping your images
Experiment with the techniques you’ve just been reading about to make selective 

adjustments to some of your images. You might also want to think about cropping.

Use the Crop tool to remove part of an image and re-frame it, as in the example below.

You could also change the orientation from landscape to portrait framing, but it’s best to 

use cropping to refine what you framed when you shot the photograph or as a dramatic 

‘effect’ in itself.

When you’ve been experimenting with different contrast, colour and crops, it’s good 

practice to Save As... and give your image a 

new file name, for example: Meadow_Crop.

Choose File > Save As...

This way you keep 

your original file. When you return to the 

image with fresh eyes, you may find that 

you went too far with your editing.
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Exercise 1.5 Experimenting with your light meter 
To prepare for Project 2 (Shadows), you’ll need to understand your light 

meter. A camera light meter measures the reflected light from the subject. 

The result is represented by a meter in your viewfinder (right). You need to 

line up the red line or needle of the light meter reading with the middle 

mark that represents a midtone and a correct exposure. You do this by 

changing the f-stop (aperture) or by changing the shutter speed. You can 

also change the ISO.

Most cameras have at least a simple centre-weighted or ‘averaging’ light 

meter that measures most of the light around the centre of the frame and 

provides an average exposure.

Some cameras have a sophisticated evaluative light meter that bases the measurement 

on typical photographic scenarios, like a bright sky in the upper half of the frame, and 

provides an exposure calculated from this.

A spot meter provides the photographer with the most control for telling the camera 

where the light reading should be taken from. A spot meter works by taking a light 

measurement from only the small ‘spot’ in the centre of the frame. You should be able to 

‘hold’ this reading while you re-frame by half-pressing the shutter.

1. Aim the spot meter area at a bright patch of sunlight or artificial light.

2. Adjust shutter speed to level out your exposure.

3. Take a photo.

Do you notice how your photograph reduces the brightest highlights to an average 

midtone and makes the shadows very dark? Try this with your other light meter types; 

you’ll find the resulting image will be different because they’ll attempt to find an 

‘average’.

Your light meter can’t know what you’re photographing, so you need to understand 

when to over-ride automatic readings and choose the midtone reference for your image. 

For example, if you photograph a snowy scene, it will probably come out under-exposed 

(too dark) because the light meter will try to average all that bright white light. You’ll 

need to deliberately over-expose (or compensate) by a few f-stops to make the white 

snow truly white instead of grey. The same thing happens the other way around with 

dark subjects, which can come out over-exposed.



40 Foundations in Photography

This project involves hunting for strong shadows and highlights in either an outdoor 

environment lit by strong sunlight. On a clear day, the hours after sunrise and before sunset 

when the sun is low on the horizon are useful for this kind of light. If it’s been raining recently, 

you’ll also find more reflections and highlights. Try to make pictures with feeling.

© Dewald Botha, OCA alumni

Exercise 1.6 Light and shadow
Before you start this exercise, have a look at the work of Trent Parke:

www.magnumphotos.com

www.in-public.com/TrentParke/

Make some notes about how Parke uses high contrast light and shadow to create telling, 

dramatic compositions.

Project 2 Shadows
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Make a series of photographic studies of light and shadow. Use your spot meter to 

expose the highlights correctly, but make the shadows dark.

Use the edges and corners of your frame to create dramatic compositions.

You’ll need to shoot many exposures for this project, perhaps more than you’re 

accustomed to taking. Be observant and go out specifically with taking pictures in mind. 

Notice:

• shadows cast by trees and people 

• patches of light 

• angular shadows cast across city streets by buildings.

Jesse Alexander
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Exercise 1.7 Evaluating your photographs
Before you upload your photos from the Shadows project, review them first on your 

camera.

Are any photos just downright dreadful? These might be photos that are out of focus, 

extremely under-exposed or over-exposed, or in which the subject is obscured. 

(Remember these keywords.) Delete them! There’s no point filling your hard drive with 

poor photos. Upload the rest of your photos to your computer, then make a visual 

evaluation.

Evaluating your own photographs is a key skill to develop during this course. It’s your 

conscious awareness of visual problems that will help you to avoid them and to make 

better photos as a result.

Here’s a list of questions to help you assess your photographs.

• What is the subject?

• Is the subject clearly visible or is it obscured?

• What’s behind the subject? Is it distracting?

• Does the composition have any other major distractions?

• Is the subject in or out of focus?

• Is the image well exposed?

• What is the contrast like?

• Is the colour balance the way you remember it?

Upload your final selection to your learning log.
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Tip: Form vs content
Properties like light and shadow, colour and contrast, framing and composition are the 

formal aspects of photography. 

Content is what your photos represent – a person, a place or an event..

As you progress through the course, try to discern the difference between form and content 

in your photos. If you progress to degree level study, you’ll find that content and meaning 

become increasingly central. For example look closely at Dave Wyatt’s photo below.

You may find some clues that contradict what appears to be a pretty English townscape. In 

fact, Thames Town is in China, built purposely to emulate an English town for the Chinese 

middle class. Dave’s photo sharply illustrates a paradox between form and content.

Dave Wyatt, Thames Town V
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Picture analysis Red Bridge, Okawa

1. Take a close look at the photograph above. What do you see? Write 

a visual description using short phrases and keywords. Describe 

theobjects you see, their shapes, colours and tones, the direction of 

lines. There’s a picture to analyse in each part of this course. Always 

start your analysis by objectively describing what you see.

2. What took your attention first? And where did your eyes move to after 

that?

3. A picture can have many subjects, but what’s the main subject? Apart 

from the objects depicted, does the photo have a metaphorical 

subject? Perhaps it has something to do with man’s intervention in 

nature.

Toshio Shibata, Red Bridge, Okawa, 2007
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4. Describe the quality of the light and shadow. Note the atmosphere or 

mood of the picture.

5. Look carefully at the composition, the way the different shapes, lines 

and tones are arranged within the frame. Make a small sketch with 

notes explaining the composition. Do the lines or shapes have a 

particular direction? Note these down on your sketch.

6. What does the title tell you?

7. Name every object, that is every ‘thing’ that’s in the picture.

8. Is what you’re seeing and what you’re describing the same thing? 

Or is there something you think you understand intuitively? Make 

a distinction between what you can see and what you’re guessing, 

feeling or intuiting.

9. What is your felt or personal response to the photograph? This is your 

experience of it.
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Exercise 1.8 Bracketing exposures
Bracketing exposures means making three to five shots of the same subject at different 

exposures. This gives you more choice to work with later, resulting in more controlled 

shadows and highlights.

1. Put your camera on a tripod or a stable surface.

2. Set to Manual mode. Make a photo of anything you like at the optimum exposure 

according to the light meter reading.

3. Now deliberately under-expose by one f-stop or by reducing the shutter speed (e.g. 

1/30th sec to 1/60th sec).

4. Take another shot, under-exposing by a further f-stop.

5. Now take a shot over-exposing from the initial optimum exposure by one f-stop or 

increasing the shutter speed.

6. Take another shot over-exposing one stop further.

7. Upload these photos to your computer to view them better.

You may notice that the under-exposed images have more tonal ‘information’ in the 

highlights and the over-exposed images have more shadow information. It’s usually 

easier to work with a slightly under-exposed photograph when conditions are difficult 

than an over-exposed one because digital cameras record shadow detail better than 

highlights.



47 Foundations in Photography

Research point - Diffused light
To prepare for the next exercise, look online at the cityscapes of Gabriele Basilico. Notice 

the smooth quality of light, the sense of space and the way architecture seems more like 

sculpture, with its shape and form emphasised. And look at the broad tonal range in Mike 

Walsh’s landscape below, which comes from the naturally occurring light and dark tones in 

the landscape. 

© Mike Walsh, OCA student
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Exercise 1.9 Soft light landscape
Search your local area for a landscape, cityscape or other external environment where 

you’re able to get a wide view of a large expanse of space. Try a high vantage point, hills, 

car parks and department stores work well. The subject of this exercise will ideally be lit 

with diffused light, so you’ll either need to wait for an overcast day, or photograph before 

the sun comes up or just after the sun has set. 

1. Photograph the landscape using a tripod to keep your camera steady, with an 

aperture of f22 (the narrowest aperture) because this will give you most depth of 

field (focus). Shoot a variety of viewpoints and compositions with the horizon low in 

the frame (more sky) and then high (more earth).

2. Bracket your exposures using the shutter speed dial. You may have to make long 

exposures of over one minute depending on the available light so it would be useful 

to use a cable shutter release to prevent you jogging the camera. When you make 

long exposures you’ll notice how light ‘gathers’ in your photograph and moving 

objects will blur.

Don’t worry about inherent bright spots like street lights or car headlights.

3. Upload your images to a computer.

4. Assess your photographs carefully. Choose one or two that are the most successful.

5. Look for the place within the image that has the darkest shadow in it and use Levels 

to make it black or dark grey. This is likely to be a shadowy edge or a silhouette. Do 

the same with the lightest point following the instructions in Exercise 1.2.

6. Use the middle slider to increase the mid-tone brightness as high as you can before it 

becomes unnatural or blocky. Your goal is to increase the perceived luminosity of the 

photograph.

7. Now re-assess your photograph. Does it look real or unreal? Have you gone too far 

with the processing? Does it represent the view you saw with your eyes or is this an 

‘image’ only a camera can create?

8. Save As…version_2 and respond to your own re-assessment. You may decide the 

photo looks better less ‘luminous’ or more ‘contrasty’, for example, or perhaps you 

prefer it in black and white.
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This project is an opportunity to produce a series of landscape or environment photographs 

that fuse the stillness inherent to photography with the movement inherent to life. First, 

though, you’ll investigate the visual effects that occur at different shutter speeds.

Exercise 1.10 Shutter speed
Make a series of experiments bracketing only the shutter speed, for example by 

using1/250th sec, then 1/60th sec, 1/15th sec, etc. You’ll go from freezing movement to 

blurring movement. 

Think about interesting moving subjects and note down some ideas: people, nature, 

machines, etc. Note the most effective ways you could photograph them: by panning the 

camera with a moving object or by holding the camera still.

Try not to fall for visual clichés; if you’ve recognised that something is a cliché, move away 

and search for something new. All visual art is refreshed by new ideas.

Project 3 Stillness and movement
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© Penny Watson, OCA student

Exercise 1.11 Capturing stillness and movement
To prepare for this exercise, research more of the work of Toshio Shibata whose images 

of dams and waterway reinforcements in Japan contrast the fluidity of water with the 

solidity of rock and concrete. They also document the way human beings interact 

forcefully with the natural environment.

Notice how rigorously composed Shibata’s photographs are. They are almost abstract in 

their use of geometric lines, angles, shapes and forms.

Shibata, like many other photographers, works in series. This means they photograph 

different instances of the same essential subject many times, often using similar 

compositions and image tonality to help the photographs sit together as a series. 

Working in series is a strategy that helps the photographer hone his or her skills when 

directed towards one particular subject. Series can help to emphasise subtleties of form 

or content.

• Choose a subject that includes both stillness and movement. Create a series from a 

variety of different instances of this subject.

When you’re assessing your photographs, try not to think in terms of what is ‘photogenic’ 

in the usual sense of the word. Go beyond that. Ask yourself if your photographs 

communicate what you intended: stillness and movement peacefulness and energy.

Do your photographs communicate any other ideas? In other words, are they symbolic or 

metaphorical? This capacity to take something unintentional and make something out of 

it is a sign that you’re developing as a photographer.
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Some classic mistakes
Amateur photographers all tend to make similar mistakes. Some visual problems can be 

resolved in image editing software, but you have to be aware of them before you can fix 

them. Look carefully at the photographs below. Can you spot the classic visual mistakes? 

Make some notes before you read any further.

In the image above: 

• The horizon isn’t straight.

• There is a lens flare on the right edge of the frame.

• It’s out of focus.

• There is an edge distraction on the bottom edge of the frame.
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This second image shows:

• under-exposure caused by pointing the camera into the sun

• a brightspot (the sun) in the image as well as lens flare

• blur caused by low shutter speed and camera shake.
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In the portrait above:

• The woman is the main subject but is out of focus.

• The background is in focus.

• A silver birch is sticking out from behind the subject’s head. This is an example of a 

background distraction coinciding with the subject.

• The red sign and green grass draw the eye away from the subject.

• The subject is too low in the frame.
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Other classic mistakes include:

• a cluttered composition

• no decisive subject

• distractions on the edges of the frame

• dust on the sensor

• verticals that aren’t straight

• people captured blinking

• red eye

• grain or pixelation caused by cropping into an image too much.

It’s better to be aware of these issues when you’re photographing so you don’t have to fix 

them later. Often they can’t be fixed – or not without compromising the image. 

Mistakes needn’t be a disaster. As with all visual art, photographers make creative use of their 

‘mistakes’. All visual properties have an effect that can be re-purposed, for example:

• the slanted horizon

• colour cast

• over-exposure

• blur

• out-of-focus.

As you do your research for this course, look for examples of this re-purposing.

Look through the photographs you’ve made so far on this course and see whether you can 

identify any of these ‘classic mistakes’. Use your image editing software to try to fix them.
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Exercise 1.12 Smash!
This exercise asks you to choose some suitable small objects that you can break! An old 

toy, some rotten fruit, a shirt or a balloon filled with water would all work well. The point 

here is to freeze a fast-moving object in an otherwise still location. You must get the 

object in sharp focus to reveal the detail of its disintegration and movement.

Choose a suitable location where you won’t make too much mess. Aim to frame the 

object quite close, with the environment around it. You’ll need to frame the object 

in front of a background that helps to emphasise it visually: that could mean a 

complementary colour (e.g. red against green) or an opposite tone (light object against 

dark background or vice versa).

Before you start, research the freeze-frame photographs of Denis Darzacq at  

www.denis-darzacq.com/

Do an online search for Harold Edgerton’s experiments. 

These photographers give you images that would be impossible without the mechanism 

of the shutter, and in Edgerton’s case, a flash.

1. Set up your camera on a tripod a few metres from the ‘impact zone’ (ground, wall or 

other) and set the shutter speed to the fastest possible for the available light. Focus 

your lens manually on the ‘impact zone’. Take a few shots to make sure the exposure is 

spot on. If you have a flash, use it.

2. Now ask an assistant (standing out of shot) to drop or throw your object onto the 

impact zone where you’ve nailed focus. (They may need to wear protective glasses 

depending on your choice of object.) Take your shot.

3. Review your photo. How was your timing? Is the shutter speed fast enough? Should 

you increase your ISO?

4. Try again...and again... it’s a trial and error process.

5. Review your images.

You should have a variety of images that show the frozen movement. However, this 

project doesn’t just illustrate the effect of a fast shutter speed, but also the significance of 

chance in photography. Even if you photographed the same kind of object ten times, the 

resultant images would all show subtly different results. This is one of the reasons why 

photographers invariably shoot a lot of exposures.

This exercise also shows how a ‘planted’ object can alter the interpretation of the 

environment.  All juxtapositions have this effect, but usually in subtler degrees.
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Exercise 1.13 Make a contact sheet
A contact sheet is a document with a collection of small ‘thumbnail’ images on it. This 

can be a printed document or a digital document like a pdf or even a Microsoft Word file. 

Contact sheets are useful for viewing images quickly. Also, viewing each image so small 

renders it more of a graphic, emphasising its main shapes and lines.

Your goal in this exercise is to make a contact sheet so Google ‘How to make a contact 

sheet in (your software).’ Or learn here for Photoshop: https://helpx.adobe.com/

photoshop/how-to/create-contact-sheets.html

And here for Bridge: https://helpx.adobe.com/bridge/using/create-web-galleries-pdfs-

adobe.html#create_a_pdf_contact_sheet
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Printing
The images captured by your camera and stored on your computer will be RGB (Red, Green, 

Blue) images, which is the ‘colour space’ that digital equipment and computer monitors 

use. Although inkjet printers use CMYK (Cyan, Magenta, Yellow & blacK) there’s no need to 

convert your images to CMYK to print them on an inkjet printer because most inkjet printers 

automatically convert to proprietary CMYK. (Converting photographs to CMYK will become 

necessary if you want to make a book of your work via an online publisher like blurb.com for 

example. They provide a CMYK profile and instructions for this.)

Printing your photographs out and putting them up on a wall is an important practice 

because repeated viewing will help you to learn from your own photos. You don’t need to 

print them large or print every photo, but do print out the images you’re working on for 

assignments.

• Use cheap Photo paper for general printing and archival quality paper, like the Brilliant 

Museum range, for your final prints.

If you’re getting banding or lines in your prints then you probably need to run the cleaning 

facility of your printer. If the colours look unnatural, it could be that you need to replace an 

ink cartridge. If the print quality is disappointing, use photo-quality paper to print on and use 

the best quality settings and resolution for your printer.

• Print images no less than 200 ppi. 300 ppi is optimum.

When you’re working on the colour and tone in a print, print small sections (test strips) of the 

image rather than the whole picture, to save paper and ink.

Print out your best photos from Exercises 1.11 and 1.12 and stick them on a wall.

© Dewald Botha, OCA alumni
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If you have serious discrepancies with colour and tone between what you see on your 

monitor and what you print, even though you have a good photo-quality printer, you may 

need to calibrate your monitor and printer. Check out X-Rite’s ColorMonki at  

www.xritephoto.com.

Uploading images to your blog
Now you’ve made some images, you can upload them to your student blog.   But you’ll want 

to process a batch of images rather than one at a time.  Here’s a link to an Adobe tutorial: 

https://helpx.adobe.com/photoshop/using/processing-batch-files.html

Exercise 1.14 Re-sizing a batch of your images 

for your blog
1. Open up Bridge and select all the images in one folder.

2. Choose Tools on the top menu bar and 

select Photoshop > Image Processor. At 

this point Photoshop will open and the 

Image Processor window opens. 

3. Choose the same settings as right, 

putting your name in the Copyright info 

box. The Quality of 5 should give you an 

image of under 1Mb – try 3 or 4 later if 

they’re still too big.

4. Click Run.

Photoshop will automatically re-size all the 

selected images, convert them to JPEGs and 

place them in a folder marked JPEG in the 

same location as the images. You can now use the re-sized images for your blog. 
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Exercise 1.15 Uploading photos to your blog
1. Log in to your Wordpress blog. 

2. Click on Dashboard, then on the left, Posts > Add New. (A ‘Post’ is like a new page or 

entry on your blog.)

3. Give the post a title – Project 2 Shadows, for example. 

4. Click in the area for text and write some text if you like; press Enter to create a space 

between the text and the image you’ll upload. 

5. Then click on the ‘Add media’ button. 

• A window opens and you need to navigate to the image file on your computer, then 

click ‘Upload’.

• Align your image as you would text. Central alignment is probably best.

• If you want to add more than one image, put a space (press Enter) after the photo 

you just uploaded, then click ‘Add media’ and re-do the process for all your images.

6. Now assign them to the correct category (categories are like chapters or sections in 

a folder) by ticking the correct Category box on the right – you may need to scroll 

down a little. For example, Part One Workflow, Project 2 Shadows.

7. Press the ‘Publish’ button to publish your work to the WorldWideWeb.

Upload all your project work so far as well as your four assignments, placing everything in 

the correct category. 

You can post your writing in the Research & reflection category. 
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Tips
The texts you write needn’t be long – particularly in the Coursework section of your blog. Try 

to express yourself concisely.

You can put longer and more in-depth research or analysis in the Research & reflection 

section of your blog.

Keep your blog tidy and easy to navigate. Above all, try to be, clear and unpretentious.

Exercise 1.16 Inviting and posting comments
Inviting comments from your fellow students and posting your own comments on their 

blogs is a vital part of learning – the equivalent of an on-line seminar – which will add 

friction, refreshing perspectives and communication to your learning experience. You’ll 

be amazed at how much you’ll learn from the responses of other people.

Please be respectful when posting comments. Calling someone’s photos ‘rubbish’ or 

‘boring’ may seem honest, but it’s actually a superficial knee-jerk reaction – and just plain 

rude.

• First add your name to the list of OCA student blogs here:  

www.oca-student.com/course-mates/directory

• Spend some time looking at the work of other OCA students and post comments 

on their blogs. You must put web links to these posts on your blog as your tutor will 

look for them. You can post them on your blog in the Research & Reflection category, 

under OCA student blogs. 
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People leave traces of their activity on the landscape whether urban or natural. They dig into 

it, leave stuff behind, make their mark and stake their claim.  Paths, graffiti, rubbish, cigarette 

burns, worn out stones and oil stains in the road are all examples of human traces. These 

marks imply that someone was there, doing something, leaving some signature of their 

existence and activity.  

In this assignment you’ll make a series of photographs that focus on and emphasize the 

traces that humankind leaves behind. If you’re lucky, and observant, your images may portray 

a palpable sense of their absence.  

You can interpret this brief freely. Often photographers start in one place, run with an ideas 

and end up with a different or surprising result. That’s OK, just let your ideas and curiosity 

guide you. 

You can choose a location that is well-known to you as a starting point – your street, your 

neighbourhood or the area you grew up in. Or somewhere you feel drawn to because of its 

visual potential.  

Perhaps rather than man-made marks, you may find nature making marks on civilization.  

Traces and marks can often be small, so try to contextualize small objects in wide shots that 

include the whole environment and give information about the character of space they’re in.  

If your photos are too close, there may be no sense of place.    

Unifying Visual Strategy
Try to think about using a unifying visual strategy to help the pictures gel together as a 

series. By ‘unified visual strategy’, we mean a way of visualizing your subject that is similar 

through all the images.  For example, if you took a series of photos of dumped objects, 

with your main subject (say a mattress) placed in the foreground of the frame with your 

viewpoint not looking down at the mattress (because that would exclude too much of the 

environment) but from a level viewpoint with the horizon, so the mattress sits in the lower 

portion of the frame. Then perhaps if you find a burnt-out car, you could photograph it from 

exactly the same kind of viewpoint and the two images would probably sit together well 

because the visual approach is similar.  But this is just one example of a visual strategy.  You 

could use a wide-angle lens for all your shots or photograph at a similar time of day.  

Assignment one Traces
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Images and Statements
Do you think the images above make a statement of some kind? Do they ‘say’ something 

– visually? To a degree, we are giving you a brief which adds content to your photographs.  

But you need to choose which traces you photograph. And you need to find out for yourself 

where it leads. 

The image above says something about the way man uses the environment as a place of 

action.

Research
Do some online research on the work of the following photographers to help inspire your 

approach to this assignment:

• Richard Misrach – Writing on the Wall

• Gina Lundy – Academy

• Lensculture’s feature on ‘forensic traces of war’

• Chloe Juno – Someones Rubbish

• Select between 8 and 12 photographs to send to your tutor. 

• Resize the images to 1500 pixels along the longest edge.

• Send them to your tutor as an email attachment with some brief notes about your 

intention. 

FINALLY...
It’s important you try to complete this assignment as soon as possible. Your tutor will use 

your assignment to get a sense of your current level of technical, visual, analytical and 

creative skills. While you should commit to the assignment and pursue an idea that interests 

you, it primarily has a diagnostic purpose so don’t labour it.


